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Abstract 

The MaMaSe Sustainable Water Initiative is aimed at improving water safety and security in the Mara 
River Basin to support structural poverty reduction, sustainable economic growth and conservation of 
the basin’s ecosystems. In this four year programme the people and institutions in the basin will be 
supported in a process of structural change, promoting water-wise economic development that lifts 
people out of poverty and sets them on a sustainable path to improved well-being and self-reliance. 
 
This toobox supports the development of a rangeland information system with different information 
“ProdUser” communities that considers spatial-temporal carrying capacity of the Maasai Mara park 
and surrounding rangelands for livelihoods based on livestock and wildlife species. Such system 
could serve early warning, and is based on GEONETCast global data dissemination and open 
geospatial data analysis technology. It supports development of rangeland management options and 
scenarios by efficient data pre-processing required. 
 
Currently large amounts of environmental data are delivered through “GEONETCast-EUMETCast”. 
ILWIS plug-ins are developed to import various data types delivered via these telecommunication 
based systems.  These systems disseminate real and near real-time environmental data which can 
be received using a low cost ground receiving station. On the other hand, various environmental data 
resources, especially time series of data, are currently available through the internet. The “MaMaSe 
Toolbox” is developed to easily ingest selected data from both sources. The generic RS and GIS 
capability offered by ILWIS can be used for further processing of the data. 
 
The toolbox is identical in design as compared to the other toolbox plug-ins, like the GEONETCast 
and ISOD Toolboxes. This document is proving a description where to download the freeware utilities 
used, how to install and configure them. The MAMASE Toolbox developed is an open utility. It can 
be easily modified and tuned to fit the specific user needs without programming skills. Next to this 
description also an overview is presented on the various data resources that can be automatically 
retrieved and processed. Finally the document provides hands-on exercises how to use the utilities 
offered. The exercises provided are focusing on the selected vegetation and precipitation (including 
forecasting) information relevant for the MaMaSe project. Further information on the MaMaSe project 
can be obtained from http://www.MaMaSe.org/.  
 
The utilities provided are extensively tested using various operating systems, such as Windows 
7/8/10 and have found to be performing in a stable manner. The toolbox currently does not work 
under LINUX. In case unexpected behaviour or bugs are observed, additions to the functionality are 
required or if you have developed new utilities which you want to share, please contact the EO 
Community Contact (http://52north.org/communities/earth-observation/community-contact).  
 
 
                                                                                                                                            
Ben Maathuis  
Department of Water Resources 
 
Bert Toxopeus 
Department of Natural Resources  
 
Faculty ITC – University of Twente 
Enschede, The Netherlands 
January 2017 
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LIST OF ACRONYMS AND ABBREVIATIONS 

52North--------------------- 
ARC------------------------- 
CHIRPS-------------------- 
CMORPH------------------ 
CPC------------------------- 
EO--------------------------- 

52°North Initiative for Geospatial Open Source Software 
Africa Rainfall estimate Climatology 
Climate Hazard Group InfraRed Precipitation with Station (data archive) 
Prediction Centre Morphing Technique for rainfall estimation 
Climate Prediction Centre 
Earth Observation 

ECMWF-------------------- European Centre for Medium-Range Weather Forecast 
eMODIS-------------------- Expedited MODIS 
ESA------------------------- 
EUMETCast--------------- 
EUMETSAT--------------- 
FTP------------------------- 

European Space Agency 
Telecommunication based data dissemination system 
European Organisation for the Exploitation of Meteorological Satellites 
File Transfer Protocol 

FEWSNET---------------- United States Agency for International Development (USAID) Famine Early 
Warning System 

GDAL----------------------- Geospatial Data Abstraction Library 
GDEM---------------------- Global Digital Elevation Model 
GFS------------------------- CPC Global Forecasting System 
GMTED-------------------- Global Multi-resolution Terrain Elevation Data 
GRIB----------------------- 
GSOD---------------------- 

GRIdded Binary 
Global Summary of Day Data 

GTS------------------------ Global Telecommunication System 
HDF------------------------ 
ILWIS----------------------- 

Hierarchical Data Format 
Integrated Land and Water Information System (GIS-RS software) 

MaMaSe----------------- Mau Mara Serengeti Sustainable Water (MaMaSe) Initiative 
MOD13-------------------- MODIS Vegetation product 
MODIS--------------------- Moderate Resolution Imaging Spectrometer 
MPE------------------------ 
NCEP---------------------- 

Multi sensor Precipitation Estimate 
National Centers for Environmental Prediction 

NDVI------------------------ Normalized Difference Vegetation Index 
NASA----------------------- National Aeronautics and Space Administration 
NetCDF-------------------- 
NOAA----------------------- 

Network Common Data Form 
National Oceanic and Atmospheric Administration 

RFE------------------------- Rainfall Estimate 
SRTM---------------------- Shuttle Radar Topographic Mission 
TAMSAT------------------- 

 
Tropical Applications of Meteorology using Satellite data and ground-based 
observations 

UTC------------------------ Universal Time Coordinated 
XML------------------------- Extensible Markup Language 
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RELEASE NOTES 

Following comments have to be taken into consideration with respect to the release of this MaMaSe 
Toolbox, XML version 1.0: 
 

1. This is the third release and utmost care was taken to ensure appropriate operation of the 
routines developed but at this stage some defects might still be included and should be 
reported to the corresponding author to be included in a new release; 

2. For the release of this toolbox version all data sources used have been checked. For some 
data sources the data format or naming conventions have changed. It was also noted some 
data has been re-processed. Furthermore Internet has a transient nature; some links might 
not be active after some time. If any of such a problems are encountered please report these 
to the corresponding author; 

3. No liability can be accepted for use of the MaMaSa Toolbox by the toolbox developers; 
4. When using ILWIS 3.8 Open or higher some functionality has changed and is not downwards 

compatible. When not familiar with ILWIS it is advised to use the latest version of ILWIS 372 
for the purpose of learning how to apply this toolbox in conjunction with other ILWIS 
functionality. When running the toolbox under ILWIS 372 and you want to use ILWIS 38 for 
visualization – animation, copy the ILWIS service objects, available under your ILWIS 372 
sub-directory “\Extensions\MAMASE-Toolbox\System” into the ILWIS 38 sub-directory 
“\system”; 

5. When using the MaMaSa-Toolbox you agree and comply with the conditions of the software 
utilities used as well as the terms and conditions stipulated by various online data providers 
for the use or references to the source of the data; 

6. Further license notes are described in the files ‘52N_EO_license.txt’, ‘CC-BY-NC-3.0.txt’ and 
‘Readme.txt’, situated in the root folder of the MaMaSe toolbox. 
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1. GENERAL INSTALLATION AND CONFIGURATION INSTRUCTIONS 

1.1 INTRODUCTION 
Follow the instructions provided below to install the latest ILWIS Version 3.7.2, the MaMaSe Toolbox 
and a number of other free software utilities, in order to work with the data provided via open internet 
resources. Read the instructions provided below carefully and proceed with the installation of the 
various utilities. In case you want to use the MaMaSe Toolbox, be aware that at this moment it is not 
running under LINUX-Ubuntu. Furthermore this MaMaSe Toolbox version is not downwards 
compatible; you need to use at least ILWIS Version 3.7.2. 

1.2 DOWNLOAD ILWIS 

Available from:  http://52north.org/ 
 
From this location select the navigation tab: “Downloads” or directly select 
“http://52North.org/downloads/ILWIS”. Select the latest (multiple file) ILWIS372 version (“ILWIS 
3.07.02”) and download the ZIP file(s), save the file(s) in a temporary directory on your hard disk. 
Unzip the file and run the ILWIS setup. When you intend to use the MaMaSe Toolbox do not install 
ILWIS372 under the default installation directory “C:\Program Files” as this might cause 
problems with respect to administration rights (especially under Windows 7) when creating temporary 
files and because the toolbox is utilizing DOS batch routines, which can be affected by the space in 
the directory file name “Program Files”. Select as your installation “drive:\directory” a location where 
you have the proper administrative rights (e.g. “D:\ILWIS372”). In the “ILWIS372” directory a shortcut 
to the “ILWIS.exe” can be created, you can copy this shortcut to the desktop of your system.  
 
Please take into consideration, straight from the start, the following golden rules when using 
ILWIS: 

 Don’t use spaces in directory or file names, instead use underscores; 
 Do not only use numbers as file names; 
 Do not work in multiple output directories; 
 Start ILWIS, navigate to your working directory and close ILWIS. Open ILWIS again to ensure 

that your current working directory is also the actual ILWIS working directory. 

1.3 DOWNLOAD THE MAMASE TOOLBOX 

Available from:  http://52north.org/ 
 
To download the MAMASE Toolbox from the 52North website: Select from the 52north.org website the 
navigation tab: “Earth Observation”. Additional information is provided over there as well as the link to 
the download area. You can also directly download the Toolbox from 
http://52north.org/downloads/earth-observation, select “MaMaSe”. Download the Zip file: “52n-eo-
MaMaSe-toolbox-1.0” available over there and store it in a temporary directory. Eventually download 
other resources provided over there. 
 
After the download is completed, copy this ZIP file in the ILWIS sub-directory “\Extensions”. There is 
no need to unzip the file! ILWIS automatically detects the ZIP file in this directory then unzips the file 
and installs the plug-in when a new instance of ILWIS is started. Afterwards the ZIP file is deleted in 
this “\Extensions” sub-directory!  
 
If an ILWIS 37 version is used, start ILWIS and in the Operation-Tree of ILWIS the “MAMASE” tab will 
appear (see also figure 1.1). Double click the “MAMASE” tab and the subsequent “Toolbox” tab and 
various (sub) menus are now at your disposal. These options can be used to import open internet 
environmental and EUMETCast selected data sets.  
 
If an ILWIS 38 version is used, use your file browser, navigate to the ILWIS sub-directory 
\extensions\geonetcast-toolbox, copy the two files with the extensions *.DLL and paste these in the 
sub-directory \extensions\MaMaSe-toolbox and start a new instance of ILWIS. Now the “MAMASE” 
tab will appear (see also figure 1.1). Double click the “MAMASE” tab and the subsequent “Toolbox” 
tab and various (sub) menus are now at your disposal. 
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Keep checking the “Earth Observation” community web pages (http://52north.org/ communities/earth-
observation/) for new (toolbox) developments. Modifications and added functionality for the MAMASE 
Toolbox are made available on these websites on an ad hoc basis, so check if you are working with 
the latest version. The XML configuration number, currently 1.0, is given on the lower left hand portion 
of the MAMASE Toolbox opening screen. 
 
 

Figure 1.1: The MAMASE main and sub menu structure under ILWIS372 

 
 
Close ILWIS as you might need to install additional utilities. Check if you have already installed 
IrfanView. If this is not case use the link below and follow the additional installation instructions. 

1.4 DOWNLOAD IRFANVIEW 

Available from:  http://www.irfanview.com/ 
 
For some data visualizations and animation that do not require import into an ILWIS data format, use 
is made of IrfanView. Download the setup executable and save it in a temporary directory on your 
hard disk. 
 
After the download has been completed run the setup, there is no need to create shortcuts, use the 
option: “For all users” and select the default Installation folder. Click “Next” three times, just use the 
default settings, “Don’t install Google Desktop Search”, click “Next” two times and after the installation 
has been completed, press “Done”.  
 
An instance of IrfanView can be started to check if the installation has been successful, the program 
can be stopped. Eventually the slide advancement, available under the Slideshow icon, can be 
changed, e.g. “Automatic after 0.85 seconds”. For good visualization of the animations a “Play in 
Window mode option can be selected, the window size is 800 by 620 (width by height) respectively. 
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1.5 CONCLUDING REMARKS 

With ILWIS, the MaMaSe Toolbox plug-in and the other necessary utility-software installed you still 
need to continue with the MaMaSe Toolbox configuration settings which are further described in the 
next chapter, next to additional information with regard to the overall toolbox architecture. 
 
Some routines use “Powershell”. If you are working on a system and do not have full administrative 
rights it is required to set the “Execution Policy” to “Unrestricted”. Also this is described further below. 
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2. OVERVIEW OF THE MAMASE TOOLBOX ARCHITECTURE 

2.1 INTRODUCTION 

The MAMASE Toolbox Config XML version 1.0 allows import of various web based environmental 
data resources and data delivered via a GEONETCast-EUMETCast ground reception station through 
a Graphical User Interface (GUI). Here the toolbox architecture is described into more detail. Once the 
toolbox is installed and ILWIS is newly started the “MAMASE Toolbox” should appear as a menu item 
under the ILWIS Operation Tree (see figure 2.1). 
 

Figure 2.1: The MAMASE Toolbox plug-in Graphical User Interface 

 

2.2 STRUCTURE OF THE MAMASE TOOLBOX 

To operate the MAMASE toolbox, the Zip file “52n-eo-MaMaSe-toolbox-1.0” is copied under the ILWIS 
sub-directory “\Extensions”. Once a new event of ILWIS372 is started this ZIP file is extracted and the 
content is stored in the sub-directory “\MAMASE-Toolbox” within the same “\Extensions” sub-directory. 
Within the “MAMASE-Toolbox” sub-directory a number of other sub-directories appear (see figure 
2.2). 
 
The folder “\GDAL” (Geospatial Data Abstraction Library) contains a translator library for raster 
geospatial data formats that is released under an X/MIT style Open Source license by the Open 
Source Geospatial Foundation (http://www.gdal. org). 
 
The folder “\System” is storing the ILWIS service objects. Service objects are used by data objects; 
they contain accessories required by data objects besides the data itself. Upon installation of the 
toolbox, these objects are copied to the main ILWIS directory \System. 
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Figure 2.2: Toolbox sub-directory structure 
  
   

The folder “\Toolbox_batchroutines” provides the 
batch files that are used to execute most of the actual 
operations. These files can be opened and modified 
using a text editor like notepad. Further information is 
provided in chapter 2.6. Before you modify a routine, 
first make a backup! 

 
The folder “\Toolbox_startscript” contains a number of 
sub-directories which contain the ILWIS scripts. Upon 
selection of an import routine, from the MAMASE 
Toolbox User Interface a script is called and this script 
subsequently calls a batch file which executes the 
operation. The scripts can also be opened and 
modified using ILWIS. Further information is provided 
in chapter 2.5. 

 
 

 
In the root of the “\Util” folder ILWIS service objects are stored, like lookup tables, georeferences, 
domains, etc. Furthermore a number of executables are stored here that are used by various toolbox 
batch routines, such as the “joinmsg” executable. The sub-directory “\7z” is containing the 7Z unzip 
utility.The sub-directory “\Maps” is containing segment-polygon files of the countries and for MAMASE 
project area. The sub-directory “\grep_wget” is storing the wget utility used to extract the selected data 
from the internet http or ftp locations and the grep utility handles string manipulations / replacements in 
command line mode. The sub-directory “\manuals” contains a number of files that provide ancillary 
information describing the nature of the data to be retrieved and this manual. The folder \ilwis_O 
contains the new ILWIS open command line version which is used for the temporal filtering routine. 
 
The file “config.xml” contains the MAMASE Toolbox GUI menu structure. This file can be edited using 
a text editor. In case the user wants to add new routines, this XML file can be adapted and modified. 
The resulting menu will be adapted accordingly when a new instance of the Toolbox is started. This 
allows users without programming experiences to adapt the toolbox to their own preferences. A more 
detailed description is provided below in chapter 2.3. 
 
The file “MaMaSe.ini” contains the settings of the input and output directories for each “folderid” that is 
defined in the “Config.xml”. This file is storing the settings as defined from the Toolbox menu options 
“Configuration” >> “Folders”. Further information on the folder settings is provided in chapter 2.4.  
 
The file “EO-Toolbox.dll” contains the layout of the User Interface of the MAMASE Toolbox and 
generates the full ILWIS command string that executes the script, batch file, defines and passes the 
parameters that are used, like the time stamp, input drive, input directory, output drive, output 
directory, ILWIS directory, etc. Up to 9 parameters are used to execute a Toolbox operation. 
 
The file “EO-Toolbox.dll.manifest” is used by the operating system for certification of the appropriate 
DLL. 
 
Furthermore included are a ‘Readme.txt’ and the ‘52N_EO_license.txt’, which can be opened using a 
text editor. These files provide relevant license and additional information on this toolbox release. The 
files ‘CC-BY-NC-3.0.txt’ and ‘GLP-v2.txt’ provide further details on the Creative Commons and GNU 
General Public License information applicable respectively. 
 
NOTE: As from ILWIS38 a new version of the “EO-Toolbox.dll” has to be used. This file can also be 
downloaded from the “Earth Observation Downloads Area” (http://52north.org/communities/earth-
observation/). When using ILWIS38, copy this file into the ILWIS directory “\Extensions\MAMASE-
Toolbox”. Eventually overwrite the existing “EO-Toolbox.dll”. The MAMASE Toolbox plug-in should 
now appear in the Operation-Tree, identical to figure 2.1 when activating ILWIS38.  
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2.3 STRUCTURE OF THE CONFIG XML 

One of the main criteria during the development of this utility was to make the toolbox as open as 
possible, allowing users with no programming experiences to make modifications. As indicated before, 
all scripts and batch routines used can be adapted by the user. Next to this, the user can also modify 
the menu of the Toolbox GUI. The file that generates the user interface, “Config.xml”, can be opened 
using a text editor. 
 
The structure of the file is kept as simple as possible. The “Level” is defining the main (Level1) and 
sub menu structure (Level2 – Level ”N”). For the “Level value=” a menu name can be defined. Within 
a certain Level a “Product value=” can be specified, which will generate the name of the respective 
(sub) menu. 
 
The string starting with “Product value=” contains mostly a number of other items, like “script”, 
“format”, “type”, “folderid” and “comment”. 

 Script: The item script defines the sub-directory were the respective ILWIS script is located 
and the name of the script that should be executed; 

 Format: The text string that can be entered here will appear in the popup window when 
importing a certain image or product. It is used to ensure that e.g. the appropriate “time 
stamp” is entered on the user interface (see the “Date” on figure 2.3). For the various data 
sets these can have different formats, in the example of figure 2.3 the “Date” stamp expected 
should have the format “yyyymmdoy” (yyyy=year, mm=month, doy= day of year). Also dd= 
day, pen=pentad, dek=Dekade are used, e.g. ”yyyymmdek”; 

 Type: This is the only part of the toolbox that does not allow user modification without 
programming experiences. Various forms, that generate the pop-up windows are available 
within the “EO-ToolboxUI.dll” and are called by their specific names given. These forms 
generate the appearance of the popup windows when importing a specific product. The popup 
menu that is given in figure 2.3 is generated from a “type” called: “ymdhm”; 

 Folderid: This item generates a folder item in the “MaMaSe.ini” file. From the main Toolbox 
menu, “Configuration” and “Folders” option, this Folder item is now available and can now be 
further specified by defining the appropriate input and output directories.  

 Comment: Additional information (one line of text) can be provided in the popup menu to notify 
the user on any specific information that might be relevant. In figure 2.3 a comment string is 
added showing the “Date” format expected (yyyydoy) and some information on the values of 
the imported ndvi.  

 
Figure 2.3: Popup menu for import MOD13 NDVI product 
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Other syntax used in the config.xml is: 
< Start of a new line 
/> End of a line 
<Level… Start of a new level 
</Level”n”> End of level “n” 

 
Note that all the text should be entered between quotation marks “”. 
 
The first few lines of the config.xml are: 
1: < MAMASE > 
2: <Version id="1.0" finder="false"/> 
3: <UIInfo icon="ESA" menu="MAMASE..Toolbox" title="MASESE"/> 
4: <Path value="Extensions\MAMASE-Toolbox" inifile="MaMaSe.ini"/> 
 
Line 1 provides the link to the plug-in and the menu name, note that this is also the last line of the 
XML. Line 2 provides the opportunity to indicate a version number, useful if modifications are done to 
the original XML. The version number is also shown in the main MAMASE Toolbox menu, in the lower 
left hand corner. The “Finder” is a utility under development, allowing a search using keywords.  The 
“UIInfo Icon” in line 3 refers to the toolbox logo used in the ILWIS Operation Tree, the “menu” provides 
the name, the “..” indicates that the menu consists of two levels, and the heading used in the toolbox 
user interface is defined by the “title”. In Line 4 the “path” defines the location of the toolbox in ILWIS 
and the “inifile” here refers to the “MaMaSe.ini” file, which provides the links to the input and output 
directories. 
 
After changes are made to the config.xml the file should be saved and a new instance of the Toolbox 
should be started, showing the adaptations. Before modifying the file first make a backup! 

2.4 GENERAL MAMASE TOOLBOX CONFIGURATION - FOLDER SETTINGS 

To conveniently work with the MAMASE Toolbox the local system output (working) directories need to 
be defined. From the main MAMASE Toolbox menu, select “Configuration” and the sub-menu 
“Folders”. In figure 2.4 below the output directory for the MOD13 Import is used as example (“D” and 
T” are the local system hard disk and mapped network drive respectively). If the folders are correctly 
specified the “Save” button should be pressed to store the ‘drive:\folder’ settings.   
 

Figure 2.4: Setting of the input and output directory structure  
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The “MAMASE.ini” file can also be edited using a text editor to change using the “find and replace” 
option e.g. the drive for all directory entries in the file. Also the full directory settings can be specified, 
as example a “folderid” of “MOD13_import” is given. When opening the “MaMaSe.ini” file, using a text 
editor, an item “[MOD13_import]” is given and the output folder can now be changed by providing the 
relevant directory names, like: 
 
    [MOD13_import] 

InputFolder=T:\MAMASE\MODIS_Data 
OutputFolder=D:\MAMASE\vegetation_process 

 
There is a “Special locations” folder to select the location of an executable. Currently the location of 
“IrfanView” and “i_view32.exe” (or newer version) needs to be specified. This freeware utility is used 
for visualization and animation of pictures that are not transformed into an ILWIS data format. Make 
sure that this folder and executable are always correctly specified. Installation instructions are given in 
chapter 1.4. 

2.5 STRUCTURE OF THE MAMASE TOOLBOX SCRIPTS 

Most of the ILWIS scripts, situated within the sub-directories within the folder “\Toolbox_startscripts\” 
directory contain a single line having an identical structure. Below an example is given of the 
extraction of the “TAMSAT Dekadal Rainfall” script “TAMSATRFE_importnc”, located in the folder 
“\Toolbox_startscripts\Precipitation”: 
 

!%7\Extensions\MAMASE-Toolbox\toolbox_batchroutines\TAMSATRFE_importnc.bat 
%1 %2  %3  %4 %5 %6 %7 %8 

 
The command line starts with: ! This syntax (!) instructs ILWIS to start an external application. The 
application that should be started is situated in “%7\Extensions\MAMASE-Toolbox\ 
toolbox_batchroutines\” and calls “TAMSATRFE_importnc.bat”. This is a DOS batch routine which 
should be executed. The parameters required to execute the batch routine are given as %1 to %8: 
 

%1 Longfilename remark: the lower left corner coordinates for the specific elevation tile 
%2 InputDrive   remark: input data drive, not used here 
%3 InputDir   remark: input data directory, not used here 
%4 OutputDrive  remark: output data drive 
%5 OutputDir   remark: output data directory 
%6 gdalDir   remark: location of GDAL directory within the toolbox 
%7 IlwDir   remark: location of the ILWIS directory 
%8 UtilDir   remark: location of the Util directory within the toolbox 

 
A number of these parameters are generated by the “EO-Toolbox.dll”, such as gdalDir, IlwDir and 
UtilDir as these are fixed locations within the toolbox. Other parameters require user interaction, such 
as longfilename, InputDrive, InputDir, OutputDrive, OutputDir, as these change based on the user 
preferences. These parameters can be interactively provided in the popup menu when importing an 
image or product, see e.g. figure 2.3 above. The “Date” field provides the “Longfilename”, input and 
output drive and directory for the “InputDrive”, “InputDir”, “OutputDrive” and “OutputDir” respectively. 
 
When pressing the “Import” button of the popup menu (see again figure 2.3) an ILWIS command line 
is generated which is executed. Using the script example above for import of a TAMSAT Dekadal 
Rainfall product, the following command line is generated and executed: 
 

!D:\Ilwis372 \Extensions\MAMASE-Toolbox\toolbox_batchroutines\TAMSATRFE_ 
importnc.bat 2017011 x  x  D: MAMASE\precipitation_process D:\Ilwis372 
\Extensions\MAMASE-Toolbox\GDAL\bin D:\Ilwis372 D:\Ilwis372 \Extensions\MAMASE-
Toolbox\util 

 
The parameters are now defined as follows: 
%1 Longfilename   2017011 (the “Date” stamp, retrieval 1st dekade of January 2017) 
%2 InputDrive    x (not used here) 
%3 InputDir    x (not used here) 



16 

 

%4 OutputDrive   D: 
%5 OutputDir   MAMASE\precipitation_process 
%6 gdalDir   C:\Ilwis372\Extensions\MAMASE-Toolbox\GDAL\bin 
%7 IlwDir    C:\Ilwis372 
%8 UtilDir    C:\Ilwis372\Extensions\MAMASE-Toolbox\util 
 
Now with all parameters set the batch file “TAMSATRFE_importnc.bat”, situated in the ILWIS 
subdirectory “\Extensions\MAMASE-Toolbox\toolbox_batchroutines\” can be executed. Starting the 
command with the “!”, ILWIS knows it has to execute an external command, given the fact that the 
extension is “.bat”, the Windows operating system knows it has to execute this file using the Windows 
Command Line Processor (CMD.exe). 
 
For a number of visualization and animation routines to view picture products (in png, gif or jpg 
formats) “IrfanView” is used. In these cases an additional parameter is defined as %9, called 
“IrfanViewDir”. This parameter defines the location of the IrfanView directory and executable. It can be 
specified under “Configuration” >> “Folders” and “Special locations” options from the MAMASE 
Toolbox User Interface. 

2.6 STRUCTURE OF THE MAMASE TOOLBOX BATCH ROUTINES 

As is the case with the ILWIS scripts, also most of the batch files follow a similar structure. As an 
example a retrieval of the “TAMSAT Dekadal Rainfall” import routine is given below. The first 6 lines 
(see line numbers) are giving some general remarks and these are shown in the command line 
window, see figure 2.5. The command “echo.” results in an empty line in the command line window, 
which is used to improve the readability of the text given in the command line window.  
 
From line 7 to line 17 in the batch file the “Date” stamp, here defined as “longfilename” is passed, 
originating from the ILWIS script, to the batch file using the “SET” command. This command displays, 
sets or removes Windows Environment Variables.  
 
When starting this import operation for the Date field the appropriate RFE map date should be 
entered, here defined as “yyyymmdek” (total of 7 characters), the first 4 digits for the year are 
subsequently defined as shortfilename1 (in line 8, first 4 characters of the input string), the month is 
defined  as shortfilename2 (in line 9, for characters 5 and 6 of the input string) and the dekade is 
assigned as shortfilename3 (in line10, as character 7 of the input string).  
 
From lines 11 to 17 the other parameters are passed, originating from the ILWIS script, to the batch 
file. Once all these parameters are known the actual import routine can start. Lines 18 to 20 ensures 
that the application moves to the appropriate output directory. Lines 21 to 22 show in the command 
line window the full date stamp which is used and shows the output directory defined (see figure 2.5). 
The items “echo.” in lines 23 and 24 creates two empty lines in the command line window.  
 
Once in the output directory line 25 starts the “Wget” utility which retrieves the requested input data 
from the specified internet location, using the appropriate file name, created based on the 
longfilename string entered, as derived from the “Date” stamp, note “rfe%shortfilename1%_ 
%shortfilename2%-dk%shortfilename3%.nc”. Line 27 sets the display of subsequent messages off. 
 
In line 28 a check is performed if the input file exists, if this file does not exist the batch routine jumps 
to the section starting with “:MESSAGE”. If the input file exists line 29 is displayed in the command line 
window, followed by 2 empty lines and then jumps to the start of the actual import routine, which 
begins at the “:START” section (line 42).  
 
If the input file does not exist (in line 28) the batch routine jumps to line 33 “:MESSAGE”, the section 
below (lines 34 to 39) are displayed, see also figure 2.5. In line 40 a “pause” command is used and the 
user has to press <enter> in order to continue. Once this is done the “GOTO END” command in line 
41 causes the routine to jump to line 57. 
 
If the data is located in the specified input drive-directory, the retrieved file is renamed in line 43, and 
imported into ILWIS  format in line 44, using GDAL.  
 



17 

 

Ancillary data, in this case a mask, only providing the African continent land area, is copied from the 
toolbox utility directory (in line 45) and the data is unzipped in line 46. 
  
Once the file is in ILWIS format, a second instance of ILWIS is executed from the command prompt in 
line 47 and the georeferenced is set. In line 48 the routine checks for no data and is assigning this to a 
value of “0”in a new output map with the suffix “b”. In line 49 a conditional statement is used, if the 
land mask = 1 (for land only) and the map with suffix “b” = 0, then assign 0, else use the RFE map 
(with suffix “b”) values. In line 50 the georeferenced is set once more. 
 
Lines 51 – 56 are deleting the files that have become obsolete. Line 57 marks the “:END” section. 
With or without the required input data line 58 is always executed, this line closes instances of ILWIS 
which have started using this batch routine.  
 
Start of batch file listing: TAMSATRFE_importnc.bat 
---------------------------------------------------------------------------------------------------------------------------------------- 
 1: @echo off  
 2: echo TAMSAT RFE product 10 day rainfall in mm 
 3: echo From archive 
 4: echo File name convention rfe2011_03-dk3.nc 
 5: echo. 
 6: echo. 
 
 7: set longfilename=%1 
 8: set shortfilename1=%longfilename:~0,4% 
 9: set shortfilename2=%longfilename:~4,2% 
10: set shortfilename3=%longfilename:~6,1% 
11: set InputDrive=%2 
12: set InputDir=%3 
13: set OutputDrive=%4 
14: set OutputDir=%5 
15: set gdalDir=%6 
16: set IlwDir=%7 
17: set UtilDir=%8 
 
18: cd\ 
19: %OutputDrive% 
20: cd %OutputDir% 
 
21: echo rfe%shortfilename1%_%shortfilename2%-dk%shortfilename3% 
22: echo your current working directory = %OutputDrive%\%OutputDir% 
23: echo. 
24: echo. 
 
25: "%UtilDir%\grep_wget\wget.exe"  
26: http://tamsat.org.uk/public_data/%shortfilename1%/%shortfilename2%/rfe%shortfilename1%_%shortfilename2%-  

dk%shortfilename3%.nc 
 
27: echo off 
28: if not exist "%OutputDrive%\%OutputDir%\rfe%shortfilename1%_%shortfilename2%-dk%shortfilename3%.nc"  goto 

MESSAGE 
29: echo The file(s) "rfe%shortfilename1%_%shortfilename2%-dk%shortfilename3%.nc" has been retrieved and transferred to 

your current working directory 
30: echo. 
31: echo. 
 
32: GOTO START 
 
33: :MESSAGE 
34: echo The input file was not found in the archive. 
35: echo Check your Date stamp settings 
36: echo Your current Date stamp used is %longfilename% 
37: echo Data is retrieved from http://tamsat.org.uk/public_data/ 
38: echo Check also manually if the data exists on ftp archive (see link above) 
39: echo Internet has a transient nature - addresses might not be valid or has changed after some time! 
 
40: pause 
 
41: GOTO END 
 
42: :START 
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43: rename rfe%shortfilename1%_%shortfilename2%-dk%shortfilename3%.nc 
rfe%shortfilename1%%shortfilename2%%shortfilename3%.nc 

 
44: "%GdalDir%\gdal_translate.exe" -of ilwis 

%OutputDrive%\%OutputDir%\rfe%shortfilename1%%shortfilename2%%shortfilename3%.nc 
%OutputDrive%\%OutputDir%\rfe%shortfilename1%%shortfilename2%%shortfilename3%a.mpr 

 
45: copy "%utildir%\maps\rfeland_mask1.zip" 
 
46: "%utildir%\7z\7z" e rfeland_mask1.zip 
47: "%IlwDir%\ilwis.exe" -C setgrf 

%OutputDrive%\%OutputDir%\rfe%shortfilename1%%shortfilename2%%shortfilename3%a.mpr %Utildir%\rfe_nc 
48: "%IlwDir%\ilwis.exe" -C 

%OutputDrive%\%OutputDir%\rfe%shortfilename1%%shortfilename2%%shortfilename3%b:=ifundef(%OutputDrive%\%Out
putDir%\rfe%shortfilename1%%shortfilename2%%shortfilename3%a,0) 

49: "%IlwDir%\ilwis.exe" -C 
%OutputDrive%\%OutputDir%\rfe%shortfilename1%%shortfilename2%%shortfilename3%:=iff(%OutputDrive%\%OutputDir
%\africaland_mask1=1 and 
%OutputDrive%\%OutputDir%\rfe%shortfilename1%%shortfilename2%%shortfilename3%b=0,0,%OutputDrive%\%OutputD
ir%\rfe%shortfilename1%%shortfilename2%%shortfilename3%b.mpr) 

50: "%IlwDir%\ilwis.exe" -C setgrf 
%OutputDrive%\%OutputDir%\rfe%shortfilename1%%shortfilename2%%shortfilename3%.mpr %utildir%\rfe_nc 

 
 
51: del rfe%shortfilename1%%shortfilename2%%shortfilename3%.nc 
52: del rfe%shortfilename1%%shortfilename2%%shortfilename3%a.mpr.aux.xml 
53: del rfe%shortfilename1%%shortfilename2%%shortfilename3%a.mp* 
54: del rfe%shortfilename1%%shortfilename2%%shortfilename3%b.mp* 
55: del rfeland_mask1.* 
56: del africaland_mask1.* 
 
57: :END 
58: "%IlwDir%\ilwis.exe" -C closeall  
---------------------------------------------------------------------------------------------------------------------------------------- 
End of Batch file listing 
 
Although the content of the batch files can vary significantly, the sequence of activities is mostly the 
same: 
 

 Some remarks are given at the start of the batch file 
 Setting of the environment variables, passing over the parameters from the ILWIS scripts to 

be used by the batch routine executed 
 Check if input data is available, if not go to the end of the batch routine 
 Retrieve or copy the original data to the local working directory specified 
 Import of the data into ILWIS format 
 Execute various ILWIS routines from the command prompt 
 Delete obsolete files 
 Close ILWIS tasks created during the batch routine execution 

 
Note that all batch routines show a command line window. Relevant information is contained in these 
windows. It is advised that the content of these windows is critically checked while waiting for the 
batch routine to finish. The batch files can be opened using a text editor. The name of the batch file 
executed can be obtained from the ILWIS command line, a sample string is given in chapter 2.5. 
Some import routines download time series of data (e.g. dekadal or monthly climatology rainfall data). 
Upon extraction of the file all data contained is imported using a batch looping procedure. For further 
information on how these procedures operate see also the reference given in chapter 2.7. Some files 
are large so adequate bandwidth is required for smooth operations, e.g. as is the case with the 
MOD13 Vegetation product files. 
 
In the example given in the batch file listing given above a date stamp should have been entered as 
“2017011”. The actual time stamp erroneously provided is “2017121” which is resulting in the fact that 
the input data cannot be found (as it is not available at this moment!) and the routine, after pressing 
<Enter> is aborted. Carefully inspect the date stamp and directory settings as indicated in the 
command line interpreter window as given in the figure below. 
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Figure 2.5: Resulting message when entering wrong date-time stamp 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When appropriate, “quotation marks” are used to specify the location of a ‘directory\executable’ as well 
as for the input original file names to ensure that batch routines keep working if encountered spaces in 
(sub-) directory names and to process input files with complex file names. To ensure proper operation 
of the batch routines stick to the golden rules as given in chapter 1.2. 
 
Some routines also use PowerShell scripts. This utility is used to create interactive pop-up menus for 
easy data entry. The PowerShell *.ps1 is activated through the batch file and is creating, based on the 
user input a text file, which is subsequently called by the next line in the batch routine. This text file 
contains the user entries and these are set as environment variables. To prevent issues running 
powershell scripts, ensure that the Execution Policy is set to “Unrestricted”, see also: 
https://msdn.microsoft.com/en-us/powershell/reference/5.1/microsoft.powershell.security/set-executionpolicy. 
 
Open an instance of powershell and type the following commands: 
 
 get-ExecutionPolicy 

set-ExecutionPolicy –ExecutionPolicy Unrestricted 
 
The “get” command shows the actual settings, if required these can be modified using the “set” 
statement. 

2.7 ADVANCED USE 

If certain operations have to be repeated on a continuous basis, e.g. import of certain products for 
which basically only the time stamp has to be modified the use of the MAMASE toolbox menu might 
be cumbersome. From the main menu of ILWIS, the command line history can be checked. Select the 
appropriate string generated through the graphical user interface, modify the time stamp and execute 
the expression again by pressing <Enter>. 
 
It is advised however, to copy the command line string that is generated through the graphical user 
interface, available from the command line in the main menu of ILWIS, to the WINDOWS command 
line processor (CMD.exe). Delete the “!” from the start of the string and execute the expression. Within 
the string the date stamp can be easily modified. Eventually this line can be copied into a new text file 
and the file can be given an extension “.bat”. Add at the beginning of each line the command “cmd /c” 
to ensure that after execution of a line the routine jumps to the next line within the batch file. This file 
can then be executed from the DOS Command prompt. With multiple lines in such a batch file only 
having different “Date” stamps, time series can be created very efficiently. Additional information on 
how to conduct these procedures is described in the “GEONETCast – DevCoCast Application 
Manual”, online available at:  http://www.itc.nl/Pub/WRS/WRS-GEONETCast/Application-manual.html. 
Also within this document an example demonstrating automated data retrieval and processing is 
presented (see chapter 4.2.4).  
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2.8 CONCLUDING REMARK 

With all the configuration settings provided you are now ready to utilize the MAMASE Toolbox and 
explore the selected data that is freely available from the Internet / GEONETCast-EUMETCast 
Environmental data stream. The main objective of this toolbox is to integrate these resources in an 
efficient manner into the Geographic Information System ILWIS, relevant for the MaMaSe Project.  
 
This document is providing links to various online metadata and background reference resources, next 
to the data archives itself (indicated within the toolbox pop-up menu). It should be noted that due to 
the transient nature of the internet some of these links might not be up to date anymore. In case this is 
noted please provide your observations to the EO Community contact available at: 
http://52north.org/communities/earth-observation/community-contact.  
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3. EXPLORING SELECTED RESOURCES USING THE MAMASE TOOLBOX 

3.1  INTRODUCTION 

Various environmental (time series) data resources are currently available on the internet and 
GEONETCast-EUMETCAST Environmental data stream relevant for a multitude of applications. Users 
are often not aware of these resources and if so, they might find it difficult to import the (multi-
temporal) data into a GIS. In order to overcome these bottlenecks, the “MAMASE” Toolbox has been 
developed. When operating the toolbox, the data is in most cases automatically retrieved (when 
possible!) and ingested into an ILWIS format. The data exchange library within ILWIS allows the user 
the export the data to other formats; furthermore the extensive image, vector and thematic data 
processing capability of ILWIS can be used for further data analysis. 
 
Within this chapter attention is given to the various data resources which can be retrieved using the 
toolbox. Additional relevant background information is presented here to obtain a better understanding 
of the data which is needed if further analysis is envisaged. References to (online) documentation are 
provided as well. In the following chapter a number of practical exercises are presented using the 
toolbox to become familiar with its functionality.  
 
The toolbox menu (XML Version 1.0) as presented in figure 2.1 has a number of main menu items. 
This menu sequence is followed below as well to present the relevant background details. 

3.2 MAMASE TOOLBOX HELP 

The HELP submenu provides additional information on the software and license information in the 
Readme. It has a link to this manual and additional information is provided on the MOD13 and MSG 
Vegetation Index User’s / Product Guide as well as the temporal filtering schedule implemented to 
process the full time series of the NDVI as from 2000 onwards. To retrieve the various documents 
available press the “Import” button.    

3.3 VEGETATION 

Routines have been developed to integrate the online (satellite derived) Vegetation products from 
MOD13 Version 006 for Index number h21 v09 and from METEOSAT 2nd generation geostationary 
(MSG) satellites. The MOD13 tile is covering the MaMaSe region. The data is retrieved from 
https://e4ftl01.cr.usgs.gov//MODV6_Cmp_C/MOLT/MOD13Q1.006/. The current routines implemented 
allow the user to download the data files for MOD13 and MSG and to import them into an ILWIS 
format for a given geographical sub window. 
 
For the MOD13 NDVI the user can conduct some additional preprocessing (remove the fill values) and 
create an ndv map with values from -1 to 1 as well as a ndv byte map, with values from 0 to 255. The 
time series extracted can be used in a temporal filter to remove noise.  
 
The MSG derived NDVI is a daily product and is disseminated through EUMETCast every day at 
approximately 00:15 UTC the next day. The NDVI daily product is generated by incremental update at 
each repeat cycle of 15 minutes during daytime, every time a new clear-sky observation is available 
for a given pixel. Here the maximum NDVI value obtained over the day is used. Data is resampled to 
the georeference used for MOD13 NDV. 
 
The MOD 13 NDV is a 16 day product, using a maximum value compositing method. Data becomes 
available online about 20 days after each 16 day cycle. To fill the gap between availability of a new 
MOD13 NDV product, the MSG derived daily NDV can be used. 
 
The online data (in HDF format) is stored under dated folders, according to calendar date. The HDF 
files have as date string in their filenames the day of year (doy) notation. The table below provides an 
overview of the structure of the webpage and corresponding data provision for normal and leap years.  
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Table 3.1: MOD13 Q1 level 006 Series data provision details 
Day of year 

(doy) 
Calendar date normal 

year (mm-dd) 
Calendar date 

leap year (mm-dd) 
001 01-01 01-01 
017 01-17 01-17 
033 02-02 02-02 
049 02-18 02-18 
065 03-06 03-05 
081 03-22 03-21 
097 04-07 04-06 
113 04-23 04-22 
129 05-09 05-08 
145 05-25 05-24 
161 06-10 06-09 
177 06-26 06-25 
193 07-12 07-11 
209 07-28 07-27 
225 08-13 08-12 
241 08-29 08-28 
257 09-14 09-13 
273 09-30 09-29 
289 10-16 10-15 
305 11-01 10-31 
321 11-17 11-16 
337 12-03 12-02 
353 12-19 12-18 

 
File name convention used is “MOD13Q1.A2000049.h21v09.006.2015136104747.hdf”. In this 
example the date provided is 2000049, corresponding to calendar date  18 February 2000, note the 
shift in calendar dates for normal and leap years as from day of year 65 onwards. The date string, for 
production date, at the end of the filename is not used. 
 
Under the Help menu the product guides are provided for the MOD13 and MSG derived NDVI 
products. Additional information on MOD13 can be obtained from 
https://lpdaac.usgs.gov/dataset_discovery/modis/modis_products_table/mod13q1. For MSG consult 
http://www.eumetsat.int/website/home/Data/Products/Land/index.html and look under Vegetation 
Products for ‘Normalised Difference Vegetation Index - MSG - 0 degree’.   
 

3.4 Precipitation 

The Global Forecast System (GFS) is a weather forecast model produced by the National Centers for 
Environmental Prediction (NCEP). Dozens of atmospheric and land-soil variables are available 
through this dataset, from temperatures, winds, and precipitation to soil moisture and atmospheric 
ozone concentration (source: https://www.ncdc.noaa.gov/data-access/model-data/model-datasets/ 
global-forcast-system-gfs).  
 
Routines implemented allow the user to view an animated sequence of a 6 day - daily forecast for 
Africa, produced by the NCEP, of rainfall and an 850Mb level forecast of temperature, relative 
humidity and streamlines (winds). For visualization of the animations IrfanView is used (see also 
chapter 1.4). This utility should be installed by the user, see installation instructions (chapter 1.4), and 
the special location folder should be correctly specified (see also chapter 2.4). 
 
The next routine allows the extraction of the 10 day – daily precipitation forecast for Africa. Daily 
forecasts are retrieved (pre-processed at ITC and provided in ILWIS format) from the ITC FTP. New 
forecasts are available at approximately 07:00 UTC each day.  
 
It is also possible to retrieve three different satellite derived rainfall products, one created by the 
University of Reading, TAMSAT (http://www.tamsat.org.uk/cgi-bin/data/index.cgi) including daily, 
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dekadal and monthly rainfall and a rainfall climatology. The other one is from the Climate Hazard 
Group, called CHIRPS (http://chg.geog.ucsb.edu/data/chirps/). Data can be retrieved for daily rainfall, 
per pentad, dekade and on monthly basis. Due to the fact that ground observations are used, the lead 
time is longer compared to TAMSAT, about 2 months. TAMSAT products are available directly after 
each dekade. For further details on each of these products use the links indicated above. 
 
The final rainfall product retrieval function implemented is extracting the MSG based multi sensor 
precipitation estimate (MPE). Each 15 minutes the satellite records the area and the rainfall is 
retrieved. The product is aggregated from a 15 minutes temporal interval to a daily interval (from 00:00 
– 23:45 UTC) and this final product is stored on the ITC FTP. Further information on this product can 
be obtained from http://oiswww.eumetsat.int/~idds/html/doc/IPWG_2002_MPE.pdf.  

3.5 EUMETVIEW 

EUMETView is a visualisation service that allows users to view EUMETSAT imagery in a more 
interactive way through an online map viewer or Web Map Service (WMS). It is currently a pilot 
service and is providing near real time geostationary satellite images in different spectral regions and 
derived products, such as satellite derived rainfall. The link to the WMS is  
http://eumetview.eumetsat.int/mapviewer/.  

3.6 GENERIC GIS Functions 

A routine is implemented here ensuring that all final products are using the same projection and map 
dimensions / resolution. The final georeference used is “MaMaSe_23m.grf”. For sake of completeness 
also the details are provided in the table below of the MOD13 NDV georeference and projection 
parameters. 
 

Table 3.2: the main georeference and projection parameters used 
 MAMASE grf/csy MOD13 NDV grf/csy 
Corners of Corners Yes Yes 
Min-X 678090.376176589870 0.00 
Min-Y 9790238.35396559160 97500777.42 
Max-X 826952.751994465830 174903.30 
Max-Y 9900043.46778083410 9950000.00 
Projection UTM UTM 
Datum WGS 1984 User Defined 
Zone 36 Southern 

Hemisphere 
37 Southern 
Hemisphere 

No. Lines 4740 863 
No. Columns 6426 755 
Pixel Size 23.166 231.66 
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4. MOD13 NDV ARCHIVE AND PROCESSED DATA 

4.1 INTRODUCTION 

For the MaMaSe Project all MOD13-Q1 Vegetation Indices 16-Day L3 Global 250m for Index number 
h21 / v09 are retrieved locally and are processed from start of product generation (doy=2000049) till 
the end of 2016 (doy=2016353) at the moment of writing. Global MOD13-Q1 data are provided every 
16 days at 250-meter spatial resolution as a gridded level-3 product in the Sinusoidal projection. New 
data becomes available about 20 days after the integration period is completed and is available at the 
NASA's Land Processes Distributed Active Archive Center (LP DAAC) located at the USGS Earth 
Resources Observation and Science (EROS) Center. 
 
Downloading these data requires a NASA Earthdata Login username and password. For the purpose 
of the project this was done and is provided internally within the appropriate routines. A new user 
account can be created at:  https://urs.earthdata.nasa.gov/users/new.  For modification  of the settings 
contact the corresponding author. For more information about the data, including documentation and 
how to properly cite the data, see: https://lpdaac.usgs.gov/.  
 

4.2 TRANSFER MOD13 DATA TO LOCAL ARCHIVE 

All available original HDF files have been downloaded and are provided in the MAMASE folder, sub- 
directory is \MODIS_Data. New datasets, for 2017 (20170101) onwards have to be downloaded using 
the routine provided. This archive is stored at an appropriate location and available internally for 
project purposes. 
 
The 250m VI product contains the Science Data Set "250m 16 days NDVI", data type is “int16”, valid 
range is “-2000 to 10000” and the scaling factor is  “0.0001”. Missing data has been assigned to a 
value of -3000. Only the NDVI layer is retrieved from the HDF file and processed. A GDAL-Warp 
routine is implemented to change from Sinusoidal to UTM projection. 

4.3 ARCHIVE DATA PROCESSING AND TEMPORAL FILTERING 

All downloaded data has been imported in ILWIS format and pre-processed. All data is available in the 
MAMASE folder, sub-directory is \Vegetation_process. For all files the doy notation is used, e.g. 
ndv_200049. Files have a suffix _b and _r for byte range and data range from -1 to 1 respectively. To 
obtain the _r ndv maps the scaling factor has been applied. For the _b map conversion (to byte range 
0-255) the following formula was applied: ndv_inmap * 0.02125 + 42.5. This is resulting in a value of 
85 where vegetation starts (source: Kees de Bie, Department of Natural Resources, ITC). 
 
The Representation to be used for the _b maps is “ndv_byte” and for the _r files is “NDVI1”.  
 
Based on the time series imported a climatology was constructed for each 16 day period for the byte 
range maps. For each year a maplist was created for both types of ndv’s. All data was visually 
inspected to check if all preprocessing was conducted appropriate using animated sequences. 
Maplists have also been created containing the given time steps over the total period, e.g. for timestep 
049 all layers from 2000 to 2016 for this time step have been selected (ndvb_clim_***, ***=doy). 
Subsequently the median value was derived and stored as climatology for this time step. A final 
maplist was created “clim_stmed”, containing the 23 time steps “clim_ndvb***” (***=doy). These 
climatologies are required for the temporal filtering routine of the most recent ndv time steps. 
 
All ndv byte maps and the climatologies are copied into the folder “\MAMASE\Filter_process” for 
further processing. 
 
For the filtering procedure use is made of the modified adaptive Savitzky-Golay filter 
(http://www.itc.nl/library/papers_2009/msc/gem/beltran-abaunza.pdf) to reduce noise in the NDVI time 
series data and forcing an upper envelope. It is a modification of the filter in TIMESAT 2.3 
(http://web.nateko.lu.se/timesat/timesat.asp). The code is developed by Willem Nieuwenhuis 
(w.nieuwenhuis@utwente.nl), ITC‐NRS, and implemented under ILWIS Objects. The input data is 
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expected as byte values (domain IMAGE) and the output data will also be byte data (domain IMAGE 
for ILWIS 3 output). Also the filter assumes 16 day data (23 images per year).  
 
For proper operation at least one year of data is recommended.  A number of options are set. The 
filter iterates using different filter window sizes as this aids in filtering without losing too much detail. By 
specifying the number of iterations, automatically the window sizes are calculated. For example 4 
iterations will generate window sizes of 3, 5, 7 and 9. The filter always starts with the smallest window 
size. The window size is calculated as <current iteration> * 2 + 1. Here “4” is applied. With these 4 
iterations specified 9 time steps are considered, four before the actual time step and 4 future time 
steps. 
 
The “upperenvelop” is set to true and the filter will use the original value in favor of the fitted value if 
the fitted value is lower than the original value. The “fitlastiteration” is set to true and therefor the filter 
will force the upper envelope for all filter window sizes except for the last.  
 
The “extendwindow” is set to true and the input maplist is extended with data from the front appended 
to the end, and data from the end appended to the beginning to account for the filter window size. The 
figure below shows the way time steps are added to the time series using the extendwindow “true” 
option, adding additional data, depending on the filter size, to the start and end of the time series. This 
is why 23 steps are required to ensure that the “yearly cycle” is maintained. 
 

Figure 4.1: Extension of the time series temporal window 
 
 
 
 
 
 
 
 
 
The overall filter schedule applied is given in appendix 3. For the filter input a maplist is required, 
specifying the 23 layers to be used during the filter procedure. As input maplist convention a 
consecutive maplist number was provided (e.g. ndv_in001, ndv_in002, etc.), resulting in a similar 
output maplist number (e.g. ndv_out001, ndv_out002, etc.). For the first three 16 day periods (in 2000) 
no actual data is available, therefore the climatology calculated for these time steps is used.  
 
The output maplist layers are having as filename convention “ndv_out***_mpl_band_0.mpr” to 
“ndv_out***_mpl_band_22.mpr” (note ***=maplist number). Given the fact that 4 iterations are used 
within the filter, output map layer 17 is not going to be changed during subsequent filter operations. 
This layer is regarded as final. From each of the ndv_out maplists this layer is copied into a new folder 
“\MAMASE\Ndv_final”, currently until ndv_out369. See also the red column in the filter schedule. 
 
For processing of current ndv maps the climatology is used for the future time steps, e.g. for 
‘ndv_in370’ the input ndv for time step 2017001 is not available. This time step is now replaced by the 
map “clim_ndvb001”. For ‘ndv_in371’ the input ndv for time step 2017001 and 2017017 are not 
available, these time steps are now replaced by the maps “clim_ndvb001” and “clim_ndvb017”. For 
‘ndv_in372’ the input ndv for time step 2017001, 2017017 and 2017033 are not available, these time 
steps are now replaced by the maps “clim_ndvb001”, “clim_ndvb017” and “clim_ndvb033”. For 
‘ndv_in373’ the input ndv for time step 2017001, 2017017, 2017033 and 2017049 are not available, 
these time steps are now replaced by the maps “clim_ndvb001”, “clim_ndvb017”, “clim_ndvb033” and 
“clim_ndvb049”. 
 
After the actual data becomes available the respective climatology time steps are replaced with the 
actual ndv maps in the map list and the map list is filtered again. Each time the value of layer 17 in the 
filtered output map list is containing more actual data and the final value is more based on actual 
observations compared to the climatology. Therefore the last 4 time steps need to be filtered a number 
of times to get the final values. 
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4.4 FINAL NDV PREPARATIONS 

As indicated above the final NDV filtered time steps (layer 17 from an output map list created by the 
filter) is copied into a folder \MAMASE\ndv_final. All maps are resampled to the mamase georeference 
and the initial files are deleted. The resampled files have as suffix *_aoi. Some of the results are 
presented in the figure below. 
 

Figure 4.2: Filtered ndv time series map for the Mamase region for a selected pixel 
 

 
Note that the x-axis is showing the time, e.g. from 1 to 386 represents 2000001 to 2016257 (16 years 
of 23 maps each and 18 maps for the year 2016)  
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5. PRACTICAL EXERCISES USING THE MAMASE TOOLBOX 

5.1 VEGETATION 

5.1.1 Introduction 

After installation of ILWIS and the MAMASE Toolbox (XML version 1.0), start ILWIS and open the 
“MAMASE” > “Toolbox” options from the left hand menu tree. Inspect the menu strings of the Toolbox 
and open the item “Configuration” > “Folders” (see also figure 2.1 and chapter 2.4). Note that here the 
assumption is made that you have created on your local system, using drive “C”, a directory called 
“Vegetation_process”. For the Folder items under MOD13_download, MOD13_filter, MOD13_import, 
MOD13_preprocess and MSG_NDV, specify the appropriate directory and press “Save” to store the 
drive:\directory settings. For the purpose of these exercise the same output directory can be used. It 
should be noted that as input folder for the MSG_NDV the user should have acces to a EUMETCast 
ground reception station archive. Note the local settings. At ITC a network mapping can be made to 
the EUMETCast file server at \\csyn009.utsp.utwente.nl\other and the data is in the folder 
MPEF_DayDec.  Close the Toolbox and use the ILWIS Navigator to move to the directory 
“C:\Vegetation_process”. Close ILWIS and start ILWIS again, ensure that the location of your 
catalogue is now “C:\Vegetation_process”. Select from the menu the “MAMASE” and “Toolbox” 
options and you are ready to start the exercises. Note that if you have changed working directory 
during an active ILWIS session, it is advised to close ILWIS and start it again. The catalogue should 
now open in the correct working directory. Also note the other “golden rules” when working with ILWIS 
(see also Chapter 1.2). 
 
From the “MAMASE” and “Toolbox” main menu select the “MAMASE Toolbox Help” menu item, 
inspect the help files provided. 

5.1.2 Download of MOD13 Vegetation products 

Within the MaMaSe project use is made of the MODIS derived NDVI. These datasets are available 
online, registration is required. If not registered, first conduct the registration. Subsequently check the 
batch file “MOD13_ndv_download.bat” and look for the strings user=XXXXX and password=XXXXX, 
replace the XXXXX with obtained username and password respectively. Save the batch file. 
 
From the “MAMASE” and “Toolbox” main menu select the “Vegetation” > “MODIS 13 Series – level 
006”  > “Download MOD13 NDVI”. Note that the “Output Directory” correctly specified and enter the 
appropriate date stamp, see also table 3.1, here a date stamp (yyyymmdd) of “20000321” is used 
(note the leap year!) and press “Import”. 
 
After the routine has finished downloading the vegetation product, navigate using your Windows 
browser to the output directory specified and check the file and note the file name convention used. 
Check the index number and the year, day of year (doy) time notation used (in this example 081). 

5.1.3 Import MOD13 NDVI 

From the “MAMASE” and “Toolbox” main menu select the menu options “Vegetation” >  “MODIS 13 
Series – level 006” > “Import MOD13 NDVI”. Note that the “Input Directory” and “Output Directory” are 
correctly specified and enter the appropriate date stamp in day of year format, see also table 3.1, here 
a date stamp of 2000081 is used and press “Import”. 
 
Display the imported map using the default settings and note the data values. The map still has the 
original values, e.g. from -3000 to 10000. Display the vector file “boundary_23m”, select from the map 
window menu the option “Add Data Layer”, navigate to the folder in your ILWIS directory 
\Extensions\MAMASE-Toolbox\util\maps and select this vector file, use under the display options 
“display boundary only”, as colour “black” can be selected. Note the map dimensions, the area 
extracted is much larger than the Mamase project area. Open also the histogram and check the 
values of the map. Subsequently open the georeference and the coordinate system service objects for 
the imported map and check their content. 
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5.1.4 Pre-processing MOD13 NDVI 

From the “MAMASE” and “Toolbox” main menu select the the menu options “Vegetation” >  “MODIS 
13 Series – level 006” > “Pre-processing MOD13 NDVI”. Note that the “Input Directory” and “Output 
Directory” are correctly specified and enter the appropriate date stamp in day of year format, see also 
table 3.1, here a date stamp of “2000081” is used and press “Import”. 
 
Display the newly create map “ndv_2000081_b” using as Representation “ndv_byte” and note the data 
values by pressing the left mouse button when scrolling the mouse over the map window. Repeat this 
procedure also for the map “ndv_2000081_r”, now use as representation “NDVI1”. Also check the map 
values. 
 

5.1.5 NDV Temporal Filtering 

From the “MAMASE” and “Toolbox” main menu select the menu options “Vegetation” >  “MODIS 13 
Series – level 006” > “NDVI Temporal Filtering”. Note that the “Input Directory” and “Output Directory” 
are correctly specified. Check the settings under  the “MAMASE” > “Toolbox” options from the left 
hand menu tree. Inspect the menu strings of the Toolbox and open the item “Configuration” > 
“Folders” and  look for MOD13_filter. It is advised to use the same input and output directory. 
 
The routine requires as input a maplist containing 23 time steps, e.g. a full yearly sequence. This 
maplist has to be created manually, from the main ILWIS menu, select the option “File” > “Create” > 
“MapList”. Adhere to the conventions as given in the appendix showing the filtering schedule.  
 
If you want to execute a filter operation, use the year 2001, download and pre-process all 23 time 
steps. Create a maplist and as Map List name enter “ndv_in024” (see filter schedule), select all 
“ndv_2001***_b” maps (23 in total) in the left hand maplist window (selected maps are indicated by a 
blue colour), press the “>” sign to add them to the right hand Create MapList window and press “OK” 
to save the new maplist . Double click with the mouse the newly created Maplist “ndv_in024”. In the 
MapList window select as display option “Open as Slide Show”, as Representation select “ndv_byte” 
and press “OK” twice, add the “boundary_23m” (no Info, boundaries only) and using the mouse with 
the left button pressed, inspect the map values. Close the animation window when finished. 
 
With the maplist created, open once more from the “MAMASE” and “Toolbox” main menu the menu 
options “Vegetation” >  “MODIS 13 Series – level 006” > “NDVI Temporal Filtering”. Note that the 
“Input Directory” and “Output Directory” are correctly specified and enter the name of the maplist, here 
“ndv_in024” is used. Execute the operation. 
 
Once more open the maplist “ndv_in024” and display the map “ndv_2001001_b” and use as 
Representation “ndv_byte”. Add to this map the vector layer showing the project region boundary and 
use the option boundaries only for display of this vector layer. Now from the main ILWIS menu, select 
“Operations” > “Statistics” > “MapList” > “MapList Graph”. In the maplist graph window, select as 
MapList “ndv_in024”, use a fixed stretch of “0 to 255”, activate the option “Always on top”. Activate the 
map window showing the previously opened map layer “ndv_2001001_b”. Browse with the mouse 
cursor over the map. Note the precipitation time series values in the graph window, the X-axis shows 
the time (from the first 16 day time step of January 2001 as time step 1 to the last 16 day time step of 
December 2001 as time step 23) and the Y-Axis the ndvi byte value during each 16 day period for the 
respective pixel. See also figure 5.1. The left hand map and graph below are representing the input 
maps / values, the right hand map and graph show the result of the filter operation. Note the more 
gradual appearance of the map / graph. 
 
Click on a number of pixels to see the temporal behaviour of the ndv for the given year for these 
pixels. Now replace the maplist with “ndv_out024”. Note the change in the values and the graph. 
Eventually copy the values of the input and output maplist, using the option “Clipboard Copy” to a 
spreadsheet and add the two curves to a graph. 
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Figure 5.1: NDV time series filter impact for run ndv_in024 

 

5.1.6 Last 5 time steps reprocessing 

Each 16 days a new NDVI map is becoming available. Given the fact that for the filter 4 iterations are 
used, also the four previous time steps have to be updated based on this new input for proper 
temporal reconstruction – fitting of the curve. 
 
For the new ndvi map a new maplist has to be created manually. This maplist should contain the 
previous 19 layers, including the latest received ndvi map and the four temporal consecutive ndvi 
maps containing the median climatology values, based on the short term median value derived from 
the overall data archive (from 2000 to 2016). 
 
Next, the maplists of the four previous time steps have to be updated manually as well, substituting 
the median map of the given time step represented by the climatology by the newly received NDVI 
representing this time step. The maps should be aligned according to their temporal sequence in a 
proper manner. The modified map list should also contain 23 time steps. 
 
Here an example is given of run 373, ndv_in373. Till now the latest ndv time step available is from 
2016353, the other (future) time steps required are based on climatology, e.g. for the first 4 time steps 
representing time step 001, 017, 033 and 049, see the filter schedule and note the time steps 
required. These are not available at this moment and are replaced by the climatology. 
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Note that the “Input Directory” and “Output Directory” are correctly specified. Check the settings under  
the “MAMASE” > “Toolbox” options from the left hand menu tree. Inspect the menu strings of the 
Toolbox and open the item “Configuration” > “Folders” and  look for “filter_auto”. It is advised to use 
the same input and output directory. From the “MAMASE” and “Toolbox” main menu select the menu 
options “Vegetation” >  “MODIS 13 Series – level 006” > “Last 5 timesteps reprocessing”.  
 
A new pop-up window appears, here you have to enter the different map lists of the current and 
previous map lists. Note that all map lists used have to be updated, to include the most recent ndv 
map time step! This involves for map list ndv_in369 that for clim_ndvb353 the layer ndv_2016353_b is 
now used, for ndv_in370, the future layer (ndv_2017001_b) is now represented by clim_ndvb001, for 
ndv_in371, ndv_2017001_b and ndv_2017017_b are now represented by clim_ndvb001 and 
clim_ndvb017 and for ndv_in372, ndv_2017001_b, ndv_2017017_b and ndv_2017033_b are now 
represented by clim_ndvb001 and clim_ndvb017 and clim_ndvb033. For ndv_in373, ndv_2017001_b, 
ndv_2017017_b, ndv_2017033_b and ndv_2017049_b are now represented by clim_ndvb001, 
clim_ndvb017, clim_ndvb033 and clim_ndvb049. Also the previous time steps of the maplists created 
can be deleted. 
 

Figure 5.2: Filtering using climatology to represent future time steps 

  
Due to the iterative nature of the temporal filter and the number of iterations used, 4 in this case, the 
last 4 time steps are reprocessed on a continuous basis. It is therefore advised to adhere to the 
naming conventions used to ensure that no errors are made as provided in appendix 3! The filter 
sequence to be applied for 2017 is given as well.  

5.1.7 MSG based NDVI 

From the “MAMASE” and “Toolbox” main menu select the menu options “Vegetation” > “MSG-based” 
> “MSG based daily NDVI”. Note that the “Input Directory” and “Output Directory” are correctly 
specified and enter the appropriate date stamp in daymonthday (yyyymmdd)  format. Here a date 
stamp of 20170105 is used and press “Import”. 
 
Display the newly create map “GNC_NDVImax_201701051200” using as Representation “NDVI1” and 
note the data values by pressing the left mouse button when scrolling on the map. Note that the 
window selected is identical to the MOD13 NDV’s, but the data is having a data range of -1 to 1. Drag 
and drop the ndv map “ndv_2000081_r” on the map window displaying the MSG derived NDVI, use 
also the “NDVI1” Representation. In the map window switch the top layer on and off to see the 
difference in resolution, as MOD13 has a spatial resolution of 231 meters and MSG is 3 kilometres. 
Note furthermore that even having a temporal acquisition rate of 15 minutes, persistently cloud 
covered regions cannot be assigned an NDVI value, therefore these pixels do not have a data value. 
Close all open map windows before you continue. 
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5.2 PRECIPITATION 

5.2.1 Introduction 

Routines have been developed to integrate the online (satellite derived) precipitation products from 
CHIRPS, TAMSAT and MSG for Africa. Also forecasting information from the National Centers for 
Environmental Prediction (NCEP) can be retrieved and visualized / processed. A number of exercises 
are presented below on the various products that can be retrieved and visualized.  
 
After installation of ILWIS and the MAMASE Toolbox (XML version 1.0), start ILWIS and open the 
“MAMASE” > “Toolbox” options from the left hand Operation-Tree (see also figure 2.1). Inspect the 
menu items of the Toolbox and open the item “Configuration” > “Folders”. Note that here the 
assumption is made that you have created on your local system, using drive “C”, a directory called 
“Precipitation_process”. For the Folder items under Chirps, TAMSAT, MSG_MPE and NCEP specify 
the appropriate directory and press “Save” to store the output drive:\directory settings. Use the ILWIS 
Navigator to move to the specific working directory, close ILWIS and open it again. ILWIS should now 
open using the selected directory. Furthermore check if IrfanView has been correctly configured, see 
also chapter 1.4 and 2.4. 

5.2.2 NCEP GFS Thematic Forecast Animation 

Latest forecasts for Africa,  issued by the National Centers for Environmental Prediction and presented 
as a set of seven panels for each 24 hour interval from 0 (analysis) to 144 hours are available at 
http://wxmaps.org/pix/af.vv.html and http://wxmaps.org/pix/af.850.html. The routine select the relevant 
thematic panels and creates an animation for the precipitation forecast and a forecast showing a 
number of  parameter, like temperature, relative humidity and stream lines for the 850 Mb pressure 
level. 
 
To import the NCEP issued precipitation forecast for Africa select from the “MAMASE” > “Toolbox” 
main menu the item “NCEP GFS Thematic Forecast Animation” > “Latest NCEP GFS Precipitation 
Forecast” sub menu. In this case only the “Output Directory” need to be correctly specified as some 
temporary data is stored here. To execute the route press “Import”. If you want to interrupt the 
animation press the <esc> button on the keyboard. 
 
To import the NCEP issued 850 Mb forecast for Africa select from the “MAMASE” > “Toolbox” main 
menu the item “NCEP GFS Thematic Forecast Animation” > “Latest NCEP GFS 850 Mb Forecast” sub 
menu. In this case only the “Output Directory” need to be correctly specified as some temporary data 
is stored here. To execute the route press “Import”. If you want to interrupt the animation press the 
<esc> button on the keyboard. Note that you are looking at an animated sequence of pictures, not 
providing  the actual data!  
 

Figure 5.3: NCEP latest forecast examples 
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5.2.3 NCEP GFS 10 day Precipitation forecasts 

At ITC a routine is executed on a daily basis to retrieve the NCEP GFS Precipitation forecasts. The 
actual 6 hourly forecasts are aggregated to 24 hours and the forecast data for 10 days is processed in 
this way. Finally the data is put on the ftp for external use. The data is provided in ILWIS format. 
 
To import the NCEP issued precipitation forecast for Africa select from the “MAMASE” > “Toolbox” 
main menu the item “NCEP GFS 10 day Rainfall Forecast” > “GFS 10 day Rainfall Forecasts” sub 
menu. In this case the “Output Directory” need to be correctly specified and a date stamp used, here 
for date (yyyymmdd) “20170113” is used. To execute the route press “Import”.  
 
Upon completion of the import open the maplist “gfsp_acc10d_20170113” and display it as an 
animated sequence, using as Representation “mpe_sum”. As it is a global product add the country 
boundaries. Select from the map window menu the option “Add Data Layer”, navigate to the folder in 
your ILWIS directory \Extensions\MAMASE-Toolbox\util\maps and select the vector file 
“countryboundaries”, use under the display options and as colour “black” can be selected. You can 
zoom in to the region of interest. Note de map values by keeping the left mouse button pressed and 
scrolling your mouse over the map window. The unit is in mm/day. Close all maps before you 
continue. 
 

Figure 5.4: NCEP GFC Rainfall forecast for 72 hrs issued at 20170113 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.2.4 CHIRPS Satellite derived Rainfall product 

The Climate Hazards Group InfraRed Precipitation with Station data (CHIRPS) is a 30+ year quasi-
global rainfall dataset. Spanning 50°S-50°N (and all longitudes), starting in 1981 to near-present, 
CHIRPS incorporates 0.05° resolution satellite imagery with in-situ station data to create gridded 
rainfall time series (see also: http://www.nature.com/articles/sdata201566). To import the daily rainfall 
data from the CHIRPS precipitation data set select from the “MAMASE” > “Toolbox” main menu the 
item “Precipitation” > “CHIRPS V2.0 per day” sub-menu. In this case only the “Date” field and the 
“Output Directory” need to be specified. As Date stamp (in yyyymmdd format) select “20160101” and 
press “Import”. Note that the lead time is at least 2 months! 
 
After the import has been completed, display the newly created map “chirps_Africa_20160101”, using 
as Representation “MPE_single”. Add the country boundaries (no Info, boundaries only) and use pixel 
information to inspect the values. 
 
To import the data from the CHIRPS pentad precipitation data (aggregated to 5 days) select from the 
“MAMASE” > “Toolbox” main menu the item “Precipitation” > “CHIRPS V2.0 per pentad ” sub-menu. In 
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this case only the “Date” field and the “Output Directory” need to be specified. As Date stamp select 
“2016016” (for the last pentad of this month!) and press “Import”. 
 
After the import has been completed, display the newly created map “chirps_Africa_201601p6”, using 
as Representation “MPE_sum”. Add the country boundaries (no Info, boundaries only) and use pixel 
information to inspect the values. 
 
Compare both rainfall maps and close them when ready. The procedure can be repeated importing 
the other temporal interval precipitation maps from CHIRPS, like the dekadal and the monthly rainfall 
maps. Note the date stamp required, for the dekadal map as date stamp “1016011”, for the first 
dekade of January 2016 is required, for the month date stamp “201601” would be required. The output 
maps created are “chirps_Africa_201601d1” and “chirps_Africa_201601” for dekadal and monthly 
rainfall respectively. As Representation “MPE_sum” or “Pseudo” can be applied for visualization of the 
rainfall maps. 
 
 

5.2.5 TAMSAT Satellite derived Rainfall product and climatology 

Dekadal and monthly rainfall estimates and anomalies derived from Meteosat Thermal Infra-Red (TIR) 
channels are based on the recognition of storm clouds and calibration against ground-based rain 
gauge data. This rainfall estimate is produced by the University of Reading, Meteorology Department, 
UK. Dekadal and daily data is available one or two days after the actual dekadal period is completed, 
and therefore the lead time is shorter compared to the CHIRPS data set. For the monthly data, the 
data is available directly after the first dekade of the next month. 
 
A number of products are available, like the daily, dekadal and monthly accumulated rainfall products 
for Africa, the dekadal and monthly accumulated rainfall anomaly products for Africa. Select 
“MAMASE” > “Toolbox” > “Precipitation” >“TAMSAT rainfall archive - Africa ” > “Daily Rainfall” > “Daily 
Rainfall from 1983 onwards”.  As date stamp specify: “20170101”. Upon completion of the import 
display the map “rfe20170101” and as Representation use “rfe_dec”. Add the country boundaries (no 
Info, boundaries only) and using the mouse with the left button pressed note the map values.  
 
To import the dekadal accumulated rainfall map of the first dekade of January 2016, select the menu 
options Select “MAMASE” > “Toolbox” > “Precipitation” > “TAMSAT rainfall archive - Africa ” > 
“Dekadal Rainfall” > “Dekadal Rainfall from 1983 onwards”  and specify as date stamp “2016011”. 
Upon completion of the import display the map “rfe2016011” and as Representation use “rfe_dec”. 
Add the country boundaries (no Info, boundaries only) and using the mouse with the left button 
pressed inspect the map values. 
 
To import the dekadal rainfall anomaly map of the first dekade of January 2016, select the menu 
options Select “MAMASE” > “Toolbox” > “Precipitation” > “TAMSAT rainfall archive - Africa ” > 
“Dekadal Rainfall” > “Dekadal Rainfall anomaly from 1983 onwards”  and specify as date stamp 
“2016011”. Upon completion of the import display the map “rfe2016011_anom” and as Representation 
use “rfe_anom_dec”. Add the country boundaries (no Info, boundaries only) and using the mouse with 
the left button pressed inspect the map values. 
 
To import the monthly accumulated rainfall map of January 2016, select the menu options “MAMASE” 
> “Toolbox” > “Precipitation” > “TAMSAT rainfall archive - Africa ” > “Monthly Rainfall” > “Monthly 
Rainfall from 1983 onwards”  and specify as date stamp “201601”. Upon completion of the import 
display the map “rfe201601” and as Representation use “rfe_month”. Add the country boundaries (no 
Info, boundaries only) and using the mouse with the left button pressed inspect the map values. 
 
Also import the monthly rainfall anomalies for January 2016 and use as Representation 
“rfe_anom_month” for the imported “rfe201601_anom” map created. Add the country boundaries (no 
Info, boundaries only) and using the mouse with the left button pressed, inspect the map values. 
 
To get an idea of the distribution of the rainfall over a longer time period the rainfall climatology 
(derived from 1983-2012) can be used. To import the Dekadal Climatology rainfall, select the menu 
options > “Precipitation” > “TAMSAT rainfall archive - Africa ” > “Rainfall Climatology” > “Dekadal 
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Rainfall from 1983 onwards” , note the output directory and press the “Import” button. After extraction 
of the file a looping routine imports all 36 dekades. From the main ILWIS menu, select “Window” > 
“Refresh” to see the updated content of the catalogue. 
 
After the import of all 36 rainfall climatology maps (rfe_clim01_1 up to rfe_clim12_3) has been 
completed, select from the main ILWIS menu “File” > “Create” > “Map List”, as Map List name enter 
“RFE10day_clim”, select all rfe_clim_month_dekade maps (36 in total) in the left hand maplist window 
(selected maps are indicated by a blue colour), press the “>” sign to add them to the right hand Create 
MapList window and press “OK” to save the new maplist. Double click with the mouse the newly 
created Maplist “RFE10day_clim”. In the MapList window select as display option “Open as Slide 
Show”, as Representation select “rfe_dec” and press “OK” twice, add the country boundaries (no Info, 
boundaries only) and using the mouse with the left button pressed, inspect the map values. Close the 
animation window when finished. 
 
Once more open the maplist “RFE10day_clim” and display the map “rfe_clim01_1”. Add to this map 
the vector layer showing the country boundaries and use the option boundaries only for display of this 
vector layer. Now from the main ILWIS menu, select “Operations” > “Statistics” > “MapList” > “MapList 
Graph”. In the maplist graph window, select as MapList “RFE10day_clim”, use a fixed stretch of “0 to 
100”, activate the options “Continuous” and “Always on top”. Activate the map window showing the 
previously opened map layer “rfe_clim01_1”. Browse with the mouse cursor over the map. Note the 
precipitation time series values in the graph window, the X-axis shows the time (from the first dekade 
of January as time step 1 to the last dekade of December as time step 36) and the Y-Axis the average 
amount of precipitation (in mm) during each 10 day period for the respective pixel. See also figure 5.5. 
 

Figure 5.5: TAMSAT time series rainfall climatology over Africa 

 
Eventually import the monthly climatology. The procedure is identical as for the dekadal climatology 
import routine. Also display it as an animated sequence and use the graph display to check the values 
of your imported time series.  

5.2.6 MSG based multi sensor precipitation estimate 

In order to overcome the gap in satellite rainfall estimates of CHIRPS and TAMSAT, another rainfall 
product can be used. The aggregated Multi Sensor Precipitation estimate is available the next day, 
after 11:00 UTC. It is produced, based on an aggregation of each 15 minutes time step of the previous 
day (from 00:00 to 23:45 UTC). An automated aggregation procedure is implemented at ITC to create 
this product and transfer it to public FTP for external use. 
 
Select “MAMASE” > “Toolbox” > “Precipitation” > “Daily MSG Multi Sensor Precipitation Estimate” > 
“MSG MPE Daily Rainfall Product”.  As date stamp specify: “20160401”. Upon completion of the 
import display the map “mpe20160412” and as Representation use “mpe_sum”. Add the project area 
vector file “boundary_23” (no Info, boundaries only) and using the mouse with the left button pressed 
note the map values. See also Figure 5.6. Note that the map is resampled to the same georeference 
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as the MODIS NDV maps. It can be that for certain time steps imported there is no rainfall in the 
extracted window! 
 

Figure 5.6: Example of the daily precipitation estimate over the area of interest 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note that visualization is made in ILWIS38, as here Openstreets map is used as backdrop image.  

5.3 EUMETVIEW 

EUMETView is a visualisation service that allows users to view near real time EUMETSAT imagery in 
a more interactive way through an online map viewer or Web Map Service (WMS), available from 
http://eumetview.eumetsat.int/mapviewer/. It is currently a pilot service. EUMETView has been 
designed to be easy in usage: 
 

 Choose the layer to display from the list; 
 Select the date and time; 
 Choose region of interest; 
 Download selected images; 
 Animate images if required. 

 
Some video tutorials to help you use EUMETView can be accessed from 
http://www.eumetsat.int/website/wcm/idc/idcplg?IdcService=GET_FILE&dDocName=VID_EUMETVIE
W_BRIEF_TUTORIAL&RevisionSelectionMethod=LatestReleased&Rendition=Web. It covers how to 
connect to EUMETView, how to add a layer and how to display a layer. 

5.4 GENERIC GIS FUNCTIONS 

In order to ensure that no errors are made during certain pre-processing routines this menu item offers 
GIS procedures which are repeatedly required. At this moment a resampling routine has been added, 
ensuring that all final maps are resampled using a nearest neighbour resampling option to the same 
georeference, here “boundary_23m” is used. The output map is having as suffic “_aoi”, so the user 
can immediately identify the new map created. Additional functions will be added later on.   
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Inspect the menu items of the Toolbox and open the item “Configuration” > “Folders”. Note that here 
the assumption is made that you have created on your local system, using drive “C”, a directory called 
“Working_dir”. For the Folder items under Working_dir specify the appropriate directory and press 
“Save” to store the output drive:\directory settings. 
 
Click in the ILWIS catalog on a map you want to resample, subsequently from the main ILWIS menu 
select the options “Edit” > “Copy Object to”, select the option copy object to ”new Directory”, now 
specify the directory, here “working_dir” and press “OK” to execute the operation and accept other 
default settings. Note that when using the ILWIS copy command also the related service objects are 
copied as well! 
 
Navigate using the Navigator button in ILWIS to the new folder, here “Working_dir”. Specify the map 
name and execute the resampling routine. Display the new map created with the suffix “_aoi”, use the 
appropriate Representation and eventually add the vector layer “boundary_32m”. 
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6. DATA EXTRACTION AND IMPORT AUTOMATION FOR GENERATION OF TIME 
SERIES PRECIPITATION DATA 

In the previous exercises you have imported a variety of precipitation products using the MAMASE 
Toolbox menu. You can keep using this procedure to import the other events from the same products 
by changing the Date stamp, e.g. each time selecting the next temporal interval. This is a 
cumbersome activity that needs user intervention. This procedure can be easily automated by copying 
the ILWIS command line string that is created each time you conduct an MAMASE toolbox routine. 
 
From the Main ILWIS menu, press the “drop down” button on the right hand side of the command line. 
You will now see the “history”. A typical command line string that is generated when using the 
MAMASE Toolbox is given below using as example the import routine used for the ‘TAMSAT 10 day 
RFE’-import (note that the command line string is given as a single line, the location of your ILWIS 
directory might be different!): 
 

!D:\Ilwis372\Extensions\MAMASE-Toolbox\toolbox_batchroutines\TAMSATRFE_importnc.bat 2016011 x  x  D: 
MAMASE\precipitation_process D:\Ilwis372\Extensions\MAMASE-Toolbox\GDAL\bin D:\Ilwis372  
D:\Ilwis372\Extensions\MAMASE-Toolbox\util 

 
Have a look at the command line above and note that “!” is used in ILWIS to call an external routine, in 
this case “fews_rfe2_10day.bat”. This batch file is executed for the time stamp “2016011” (for the 1st  
dekade of January 2016). The “x” indicates that here no input drive and input directory is used. All 
other strings define the parameters that specify the locations of the required software utilities to 
conduct the operation. In your case the location of ILWIS might be in a different ‘drive:\directory’ and 
therefore your command line string might look different, but the string will have the same number of 
“items / parameters”. See also chapter 2.6 for further details. 
 
Once more execute this operation from the toolbox menu and subsequently copy this command line to 
clipboard, open ‘Notepad’ and paste the command line string as a single line into Notepad (Check 
from the Notepad menu > Format > Word Wrap off!). Delete the “!” at the start of the line and add the 
following syntax: cmd /c instead. The line now becomes: 
 

cmd /c D:\Ilwis372\Extensions\MAMASE-Toolbox\toolbox_batchroutines\TAMSATRFE_importnc.bat 2016011 
x  x  D: MAMASE\precipitation_process D:\Ilwis372\Extensions\MAMASE-Toolbox\GDAL\bin D:\Ilwis372 
D:\Ilwis372\Extensions\MAMASE-Toolbox\util  

 
Now copy this modified line and paste it 2 more times. Modify for the 3 lines the date stamp, instead of 
“2016011”, enter as new date stamps: “2016021”, “2016022” and “2016023” respectively. Your final 
results (as 3 lines) should look like the example below: 

------------------------------------------------------------------------------------------------------------------------ 
cmd /c D:\Ilwis372\Extensions\MAMASE-Toolbox\toolbox_batchroutines\TAMSATRFE_importnc.bat 2016021 
x  x  D: MAMASE\precipitation_process D:\Ilwis372\Extensions\MAMASE-Toolbox\GDAL\bin D:\Ilwis372 
D:\Ilwis372\Extensions\MAMASE-Toolbox\util  

 
cmd /c D:\Ilwis372\Extensions\MAMASE-Toolbox\toolbox_batchroutines\TAMSATRFE_importnc.bat 2016022 
x  x  D: MAMASE\precipitation_process D:\Ilwis372\Extensions\MAMASE-Toolbox\GDAL\bin D:\Ilwis372 
D:\Ilwis372\Extensions\MAMASE-Toolbox\util  

 
cmd /c D:\Ilwis372\Extensions\MAMASE-Toolbox\toolbox_batchroutines\TAMSATRFE_importnc.bat 2016023 
x  x  D: MAMASE\precipitation_process D:\Ilwis372\Extensions\MAMASE-Toolbox\GDAL\bin D:\Ilwis372 
D:\Ilwis372\Extensions\MAMASE-Toolbox\util  
------------------------------------------------------------------------------------------------------------------------ 

Save this file in your active working directory, use as file name “rfetamsat_feb16_import.bat”. 
 
Now use the Windows Explorer, browse to your active working directory and double click with the 
mouse on the new batch file created “rfetamsat_feb16_import.bat”. The RFE maps are now 
automatically retrieved and processed in ILWIS. When the operation has been completed, click with 
the mouse on the ILWIS catalogue and press “F5” or select from the ILWIS main menu “Window” > 
“Refresh”. Now create a maplist of the 3 imported dekadal images and show this as an animation. 
Also use maplist statistics, and the “sum” option, to calculate the monthly precipitation of February 
2016. Display the map using as Representation “rfe_month”. Add the country and project area 
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boundaries (no Info, boundaries only) and use pixel information to inspect the values, eventually use 
the option “MapList Graph” to see the rainfall characteristics over the whole year. 
 
Repeat this procedure, now prepare a batch file to import all RFE 10 day rainfall products for 2016 (36 
events) and calculate the sum, min, max and mean yearly precipitation for 2016. 
 
Your final results (for the sum) should resemble those provided in figure 6.1, using a “Pseudo” 
Representation and a stretch from 0 to 1500. Note that more advanced batch procedures can be 
developed, using a so called “looping” procedure, identical to the import of the TAMSAT Climatology 
products. You can find examples of these files in the “toolbox_batchroutines” sub-directory. 
 

Figure 6.1: RFE from TAMSAT based total precipitation over Africa for 2016 
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7. CONCLUSIONS 

This manual is mainly focussing on data retrieval and visualization of the various free environmental 
data sources residing on the internet and disseminated through GEONETCast-EUMETCast. Within 
the MaMaSe project the focus is firstly on NDVI and rainfall retrieval. For the NDVI it was decided to 
use the MOD13 product time series. As these have a lead time and become available 20 days later for 
the most recent period the NDVI derived from the SEVIRI instrument on Meteosat Second Generation 
is used as a proxy. These products are disseminated through GEONETCast-EUMETCast the next 
day. 
 
For rainfall data from CHIRPS can be used. Here the situation is identical as with respect to the NDVI. 
The CHIRPS products become available at least two months later. To fill the gap use can be made of 
the TAMSAT rainfall products. As these also become available with a short time delay the last 10 days 
can be covered by the Multi Sensor Precipitation Estimate, these products are available the next day.  
 
For rainfall, as it is a quickly changing and important parameter, also forecasting information can be 
retrieved, based on the Global Forecasting System, a numerical global weather prediction model. 
 
The toolbox has been used to process the NDV time series and an archive of processed data has 
been created during development of this utility. A structured method is proposed and provided in the 
appendix, showing the user how to continue processing the data. The same archive was also used to 
calculate the short term climatology, which is used within the temporal filtering routine to parameterize 
the future time steps. 
 
A method is shown to quickly generate rainfall time series. For further automation additional effort is 
required, which is outside of the scope of providing a generic toolbox.  



42 

 

This page is blank 



43 

 

APPENDICES 

Appendix 1: Other utilities available at the EO Community web pages at 52North.org 

Various other software utilities have been developed over time are released via the 52North.org web 
portal, through the Earth Observation Community, available at: http://52north.org/communities/earth-
observation/overview. A short overview of the freely available ILWIS plug-ins is presented below. Also 
dedicated ILWIS scripts are available to import the Culture MERIS, MERIS Reduced Resolution S10 
and METOP AVHRR-S10 data (under data bases) as well as various documents and useful links. 
 
 

ILWIS plug-ins to handle free Environmental data sources 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
  

Current data dissemination systems, like 
GEONETCast, provide free, near real-time 
Environmental and Earth Observation data 
together with derived products to a worldwide 
user community. The environmental data is 
delivered on a global scale via communication 
satellites. Next to this, a multitude of 
environmental relevant data is residing in 
online archives. To integrate this information 
toolbox plug-ins have been developed, also 
dealing with specific geographic regions only 
upon user request, like the AMESD-SADC 
Toolbox and the Water and Food Security 
Toolbox for Ethiopia.  
 
The toolbox plug-ins, coupled with the existing 
ILWIS processing utilities, facilitate easy 
integration of large amounts of environmental 
data into various applications related to 
weather, atmosphere, oceans, land, vegeta-
tion, water and environment.  
 

General Key Features: 
 open design and easy user configuration  
 GEONETCast automated data management system for 

dedicated storage of data 
Features GEONETCast Toolbox Version 1.7 

 import routines for various satellites, Meteorological Product 
Extraction facility (MPEF), Satellite Application Facilities 
(SAF’s), Chinese Meteorological Administration and 3rd party 
data providers such as TAMSAT, DevCoCast, MODIS, SPOT 
Vegetation 

 integration of METOP-AVHRR and JASON-2 data 
 export routines to BILKO and R 
 calculation of solar and MSG zenith and azimuth angles 
 real time METEOSAT Second Generation visualization 

Features Water and Food Security–Ethiopia Toolbox Version 1.3 
 processing selected GEONETCast data relevant for water and 

food security monitoring and analysis for Ethiopia, including 
Meteorological Data Dissemination Service routines 

Features ISOD Toolbox Version 1.4 
 retrieval and import of data from various free online archives 

related to in situ climatological observations, gauge and 
satellite derived rainfall estimates, weather and pressure 
forecasts, potential evapotranspiration, normalized difference 
vegetation indices, ocean and elevation information 

Features MESA-SADC Toolbox Version 1.0 
 import and pre-processing of all products disseminated by the 

MESA-SADC program for southern Africa, related to 
agriculture, drought and fire 
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Appendix 2: Utilities available at the ITC GEONETCast web pages 

For access to the Capacity Building utilities use can be made of the information and documents 
posted on: http://www.itc.nl/Pub/WRS/WRS-GEONETCast. Various documents are presented here 
providing further information on data dissemination systems providing a multitude of free 
environmental information, without the need for internet access but using a local ground receiving 
station for reception of the data. 
 
For more advanced use of the environmental information in ILWIS use can be made of the so-called 
“GEONETCast-DevCoCast Application manual”, providing various exercises, including description, 
exercise data and powerpoint presentation. Also other training materials are available from the ILWIS 
community at http://52North.org as well as from http://www.itc.nl/ilwis/downloads/ilwis33.asp, check 
the left hand “Documentation” and “Applications” tabs. 
 
Also a Moodle based Capacity Building portal, the “Earth Observation Capacity Building Portal” is 
under construction, providing a lot course materials provided during various workshops conducted. 
The link to this resource is http://eocbportal.itc.utwente.nl/.   It does not require a password, you can 
login as guest. 
 
Finally various resources, like scripts, base maps, sample data, etc. are also posted at 
ftp://ftp.itc.nl/pub/52n/ for easy access by the user community.  
 
 
 

Appendix 3: Filtering schedule 

Below the details on the filtering schedule are provided. Note that the last data downloaded for ndv 
filter processing is “ndv_2016353”.  The first time steps of the filtering table are not available in the 
source data, therefore time steps 2000001 – 2000033 are replaced by the climatology calculated for 
the time series (from 2000-2016). 
 
 
 



output maplist 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 name
run input maplist 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23

2000
1 ndv_in001 clim_001 clim_017 clim_033 2000049 2000065 2000081 2000097 2000113 2000129 2000145 2000161 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 ndv_out001
2 ndv_in002 clim_017 clim_033 2000049 2000065 2000081 2000097 2000113 2000129 2000145 2000161 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 ndv_out002
3 ndv_in003 clim_033 2000049 2000065 2000081 2000097 2000113 2000129 2000145 2000161 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 ndv_out003
4 ndv_in004 2000049 2000065 2000081 2000097 2000113 2000129 2000145 2000161 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 ndv_out004
5 ndv_in005 2000065 2000081 2000097 2000113 2000129 2000145 2000161 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 ndv_out005
6 ndv_in006 2000081 2000097 2000113 2000129 2000145 2000161 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 ndv_out006
7 ndv_in007 2000097 2000113 2000129 2000145 2000161 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 ndv_out007
8 ndv_in008 2000113 2000129 2000145 2000161 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 ndv_out008
9 ndv_in009 2000129 2000145 2000161 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 ndv_out009
10 ndv_in010 2000145 2000161 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 ndv_out010
11 ndv_in011 2000161 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 ndv_out011
12 ndv_in012 2000177 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 ndv_out012
13 ndv_in013 2000193 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 ndv_out013
14 ndv_in014 2000209 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 ndv_out014
15 ndv_in015 2000225 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 ndv_out015
16 ndv_in016 2000241 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 ndv_out016
17 ndv_in017 2000257 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 ndv_out017
18 ndv_in018 2000273 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 ndv_out018
19 ndv_in019 2000289 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 ndv_out019
20 ndv_in020 2000305 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 ndv_out020
21 ndv_in021 2000321 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 ndv_out021
22 ndv_in022 2000337 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 ndv_out022
23 ndv_in023 2000353 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 ndv_out023

2001
24 ndv_in024 2001001 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 ndv_out024
25 ndv_in025 2001017 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 ndv_out025
26 ndv_in026 2001033 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 ndv_out026
27 ndv_in027 2001049 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 ndv_out027
28 ndv_in028 2001065 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 ndv_out028
29 ndv_in029 2001081 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 ndv_out029
30 ndv_in030 2001097 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 ndv_out030
31 ndv_in031 2001113 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 ndv_out031
32 ndv_in032 2001129 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 ndv_out032
33 ndv_in033 2001145 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 ndv_out033
34 ndv_in034 2001161 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 ndv_out034
35 ndv_in035 2001177 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 ndv_out035
36 ndv_in036 2001193 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 ndv_out036
37 ndv_in037 2001209 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 ndv_out037
38 ndv_in038 2001225 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 ndv_out038
39 ndv_in039 2001241 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 ndv_out039
40 ndv_in040 2001257 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 ndv_out040
41 ndv_in041 2001273 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 ndv_out041
42 ndv_in042 2001289 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 ndv_out042
43 ndv_in043 2001305 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 ndv_out043
44 ndv_in044 2001321 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 2002305 ndv_out044
45 ndv_in045 2001337 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 2002305 2002321 ndv_out045
46 ndv_in046 2001353 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 2002305 2002321 2002337 ndv_out046

2002
47 ndv_in047 2002001 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 2002305 2002321 2002337 2002353 ndv_out047
48 ndv_in048 2002017 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 2002305 2002321 2002337 2002353 2003001 ndv_out048
49 ndv_in049 2002033 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 2002305 2002321 2002337 2002353 2003001 2003017 ndv_out049
50 ndv_in050 2002049 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 2002305 2002321 2002337 2002353 2003001 2003017 2003033 ndv_out050
51 ndv_in051 2002065 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 2002305 2002321 2002337 2002353 2003001 2003017 2003033 2003049 ndv_out051
52 ndv_in052 2002081 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 2002305 2002321 2002337 2002353 2003001 2003017 2003033 2003049 2003065 ndv_out052
53 ndv_in053 2002097 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 2002305 2002321 2002337 2002353 2003001 2003017 2003033 2003049 2003065 2003081 ndv_out053
54 ndv_in054 2002113 2002129 2002145 2002161 2002177 2002193 2002209 2002225 2002241 2002257 2002273 2002289 2002305 2002321 2002337 2002353 2003001 2003017 2003033 2003049 2003065 2003081 2003097 ndv_out054
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292 ndv_in292 2012241 2012257 2012273 2012289 2012305 2012321 2012337 2012353 2013001 2013017 2013033 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 ndv_out292
293 ndv_in293 2012257 2012273 2012289 2012305 2012321 2012337 2012353 2013001 2013017 2013033 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 ndv_out293
294 ndv_in294 2012273 2012289 2012305 2012321 2012337 2012353 2013001 2013017 2013033 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 ndv_out294
295 ndv_in295 2012289 2012305 2012321 2012337 2012353 2013001 2013017 2013033 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 ndv_out295
296 ndv_in296 2012305 2012321 2012337 2012353 2013001 2013017 2013033 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 ndv_out296
297 ndv_in297 2012321 2012337 2012353 2013001 2013017 2013033 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 ndv_out297
298 ndv_in298 2012337 2012353 2013001 2013017 2013033 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 ndv_out298
299 ndv_in299 2012353 2013001 2013017 2013033 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 ndv_out299

2013
300 ndv_in300 2013001 2013017 2013033 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 ndv_out300
301 ndv_in301 2013017 2013033 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 ndv_out301
302 ndv_in302 2013033 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 ndv_out302
303 ndv_in303 2013049 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 ndv_out303
304 ndv_in304 2013065 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 ndv_out304
305 ndv_in305 2013081 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 ndv_out305
306 ndv_in306 2013097 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 ndv_out306
307 ndv_in307 2013113 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 ndv_out307
308 ndv_in308 2013129 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 ndv_out308
309 ndv_in309 2013145 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 ndv_out309
310 ndv_in310 2013161 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 ndv_out310
311 ndv_in311 2013177 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 ndv_out311
312 ndv_in312 2013193 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 ndv_out312
313 ndv_in313 2013209 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 ndv_out313
314 ndv_in314 2013225 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 ndv_out314
315 ndv_in315 2013241 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 ndv_out315
316 ndv_in316 2013257 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 ndv_out316
317 ndv_in317 2013273 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 ndv_out317
318 ndv_in318 2013289 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 ndv_out318
319 ndv_in319 2013305 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 ndv_out319
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320 ndv_in320 2013321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 ndv_out320
321 ndv_in321 2013337 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 ndv_out321
322 ndv_in322 2013353 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 ndv_out322

2014
323 ndv_in323 2014001 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 ndv_out323
324 ndv_in324 2014017 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 ndv_out324
325 ndv_in325 2014033 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 ndv_out325
326 ndv_in326 2014049 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 ndv_out326
327 ndv_in327 2014065 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 ndv_out327
328 ndv_in328 2014081 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 ndv_out328
329 ndv_in329 2014097 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 ndv_out329
330 ndv_in330 2014113 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 ndv_out330
331 ndv_in331 2014129 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 ndv_out331
332 ndv_in332 2014145 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 ndv_out332
333 ndv_in333 2014161 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 ndv_out333
334 ndv_in334 2014177 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 ndv_out334
335 ndv_in335 2014193 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 ndv_out335
336 ndv_in336 2014209 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 ndv_out336
337 ndv_in337 2014225 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 ndv_out337
338 ndv_in338 2014241 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 ndv_out338
339 ndv_in339 2014257 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 ndv_out339
340 ndv_in340 2014273 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 ndv_out340
341 ndv_in341 2014289 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 ndv_out341
342 ndv_in342 2014305 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 ndv_out342
343 ndv_in343 2014321 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 ndv_out343
344 ndv_in344 2014337 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 ndv_out344
345 ndv_in345 2014353 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 ndv_out345

2015
346 ndv_in346 2015001 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 ndv_out346
347 ndv_in347 2015017 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 ndv_out347
348 ndv_in348 2015033 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 ndv_out348
349 ndv_in349 2015049 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 ndv_out349
350 ndv_in350 2015065 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 ndv_out350
351 ndv_in351 2015081 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 ndv_out351
352 ndv_in352 2015097 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 ndv_out352
353 ndv_in353 2015113 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 ndv_out353
354 ndv_in354 2015129 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 ndv_out354
355 ndv_in355 2015145 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 ndv_out355
356 ndv_in356 2015161 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 ndv_out356
357 ndv_in357 2015177 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 ndv_out357
358 ndv_in358 2015193 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 ndv_out358
359 ndv_in359 2015209 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 ndv_out359
360 ndv_in360 2015225 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 ndv_out360
361 ndv_in361 2015241 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 ndv_out361
362 ndv_in362 2015257 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 ndv_out362
363 ndv_in363 2015273 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 ndv_out363
364 ndv_in364 2015289 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 ndv_out364
365 ndv_in365 2015305 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 ndv_out365
366 ndv_in366 2015321 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 ndv_out366
367 ndv_in367 2015337 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 ndv_out367
368 ndv_in368 2015353 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 ndv_out368

2016
369 ndv_in369 2016001 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 ndv_out369
370 ndv_in370 2016017 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 ndv_out370
371 ndv_in371 2016033 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 ndv_out371
372 ndv_in372 2016049 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 ndv_out372
373 ndv_in373 2016065 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 ndv_out373
374 ndv_in374 2016081 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 ndv_out374
375 ndv_in375 2016097 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 ndv_out375
376 ndv_in376 2016113 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 ndv_out376
377 ndv_in377 2016129 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 ndv_out377
378 ndv_in378 2016145 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 ndv_out378
379 ndv_in379 2016161 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 ndv_out379
380 ndv_in380 2016177 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 ndv_out380
381 ndv_in381 2016193 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 2017177 ndv_out381
382 ndv_in382 2016209 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 2017177 2017193 ndv_out382
383 ndv_in383 2016225 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 2017177 2017193 2017209 ndv_out383
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384 ndv_in384 2016241 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 2017177 2017193 2017209 2017225 ndv_out384
385 ndv_in385 2016257 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 2017177 2017193 2017209 2017225 2017241 ndv_out385
386 ndv_in386 2016273 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 2017177 2017193 2017209 2017225 2017241 2017257 ndv_out386
387 ndv_in387 2016289 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 2017177 2017193 2017209 2017225 2017241 2017257 2017273 ndv_out387
388 ndv_in388 2016305 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 2017177 2017193 2017209 2017225 2017241 2017257 2017273 2017289 ndv_out388
389 ndv_in389 2016321 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 2017177 2017193 2017209 2017225 2017241 2017257 2017273 2017289 2017305 ndv_out389
390 ndv_in390 2016337 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 2017177 2017193 2017209 2017225 2017241 2017257 2017273 2017289 2017305 2017321 ndv_out390
391 ndv_in391 2016353 2017001 2017017 2017033 2017049 2017065 2017081 2017097 2017113 2017129 2017145 2017161 2017177 2017193 2017209 2017225 2017241 2017257 2017273 2017289 2017305 2017321 2017337 ndv_out391
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